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INTRODUCTION

BioOreo Pro is the 3D character animation tool used to create the animated
dinosaurs in Nanosaur.  This tool’s predecessor, BioOreo was used to do the
animated characters in Weekend Warrior.

The main difference between BioOreo and BioOreo Pro is that BioOreo Pro
uses “skinned” geometries instead of “jointed” geometries.  What this
means is that BioOreo Pro performs animation on a 3D model by deforming
a single contiguous mesh.  This results in a much more realistic looking
animation than was previously possible using segmented models.  When a
leg moves, the skin is stretched and deformed just like the real thing.

BioOreo Pro is a fairly complex tool to use and does take patience.  Creating
an animated character involves the following steps:

1. Create the model in a good 3D modeling program.  We recommend
Form*Z.

2. Optimize the 3D model with 3DMF Optimizer.
3. Load the optimized model into BioOreo Pro’s Bones Editor.
4. Create a skeleton under the source model.
5. Assign vertices to bones.
6. Create character animations with the keyframe animator.

This documentation is going to lead you through the process step by step,
but the first thing we’ll do is load up a sample “skeleton” to get a feel for
the tool.



MANIPULATION AND ANIMATION

When you launch BioOreo Pro, you will see 3 windows:

• Articulation
• Skinned
• Animation Timeline

The Articulation window is where you will manipulate your 3D model.  The
skinned window will show you a rendered preview of the manipulated
model.  The Animation Timeline window shows you the currently selected
animation and all of its keyframe data.

OPENING A SKELETON

The first thing we want to do is load in a sample model.  Animated
characters are stored as 2 files: a 3DMF file containing the actual 3D model,
and a “.skeleton” file which contains the skeleton and animation data for
the character.  Skeleton files know which 3DMF file they need to use, so
when we open a character to work with, we only need to open the skeleton
file.  Simply select Open Skeleton from the File menu and select
“Diloph.skeleton” in the SampleFiles folder.

WHAT’S IN THOSE WINDOWS?

When you open the skeleton file, you will see all three of the display
windows change.  The Articulation window will show you the following:



The Articulation window showing the Dilophosaurus.

In this window you can see the skeleton of the dinosaur.  In the upper
right corner are the command buttons.  You click on these buttons to select
an editing mode.  At the bottom of the window is the information bar.  This
will display information about the currently selected “joint.”

In the Skinned window, you will see a rendered image of the skeleton:



A rendered view of the skeleton

As you manipulate the skeleton in the Articulation window, the Skinned
window will update showing you the current model.  Also, when you run
an animation, this window is where the animation will be viewed.

Finally, the Animation Timeline window will display the currently selected
animation:



This character’s Stand-Spit animation display

Characters can have any quantity of animations – an animation being a
walk cycle, standing, jumping, dying, etc.  When you open a skeleton file,
the Animation Timeline displays the animation which was current when
the skeleton file was saved.  In the case of this demo, the “Stand-Spit”
animation is what we see.

We will go into more detail on the icons in the Animation Timeline window
later, but for now note that the icons across the top of the window are the
“Animation Events.”  These indicated special animation events which
perform certain tasks.  The red icons (some connected with green lines) are
the actual animation keyframes.  The names of the skeleton’s joints are
listed in the left column, and across each row are the animation keyframes
for each particular joint.

MANIPULATING THE SKELETON

Camera Navigation

All skeleton manipulation happens in the Articulation window.  You can
navigate the camera around this window by several means.  First, click
anywhere in the “black” space and drag the mouse.  This causes the camera
to orbit around the skeleton so you can see it from any angle.  Next, press
the up and down arrows to zoom in and out.  Notice that as you navigate,
the camera also updates in the Skinned window.



Skeleton Manipulation Icons

There are 4 icons in the Articulation window’s command bar:

Rotate Move Scale Look-At

The last icon, isn’t actually a skeleton manipulation mode.  When this icon
is selected, you can click anywhere on the skeleton to cause the camera to
look at that point.  It’s just another navigation tool.  You can also click
anywhere on the model in the Skinned window to do a look-at without
selecting the Look-At icon.

Rotating Joints

So, select the Rotate icon in the command bar.  You are now in rotate mode
which means that when you click on a skeleton’s joint, you can rotate it.
Select any of the yellow boxes in the Articulation window to select the
joint.  Notice that the joint is now surrounded by red, green, and blue rings:



These colored rings are your rotation axes guides.  Red is the x-axis, green
is the y-axis, and blue is the z-axis.  To rotate the joint, simply click and
drag on one of these three axes to rotate the joint around that axis.  You
can free-form rotate the joint without axis lock by clicking and dragging
directly on the joint itself, but this is not a recommended way to rotate
joints because it is very difficult to control.

Try clicking on several different joints and rotating them with the axes to
get a good feel for how this works.  You will be using this mode quite a lot
when creating your character animations.

Moving Joints

Now select the Move icon to go into Move mode.  Note that the colored
rings have turned into colored bars:



These colored bars also represent the x, y, and z axes, but the bars indicate
that you are in Move mode instead of rotate mode.  To move a joint along
any of the axes, simply click and drag on the axis you want.

You won’t be using Move mode as much as rotate mode, however, moving
joints will give your animation that subtle touch of realism that just
rotating joints cannot do.

Scaling Joints

Finally, select the Scale icon to enter Scale mode.  Scaling in BioOreo Pro is
done uniformly on a joint, therefore, there are no colored axes guides.
Simply click and drag on a joint to scale it bigger and smaller.

VIEWING ANIMATION SEQUENCES

Selecting An Animation

Now let’s skip over to the Animation Timeline window.  The sample model
you have loaded has several animations applied to it.  The name of the
currently selected animation appears in the upper-left corner of the
window.  To select a different animation, simply click on the animation
name and a pop-up menu will appear which has a list of all of the
animations currently assigned to this character.

Click on the animation name and select “run” from the pop-up menu.  The
information displayed in the Animation Timeline window will change to
show you the keyframe data for this character’s run animation:



The Articulation and Skinned windows will also update to show the
position of the character at “time zero” for this animation.

The Animation Time Index

The yellow icon at the top left of the Animation Timeline window is the
Time Index.  This indicates the current time position in the animation.
Click and drag on this icon to move the time index to any point in the
animation sequence.  As you drag the icon, the Articulation and Skinned
windows will update to the current position of the skeleton at the given
time index.

Playing an Animation Sequence

Dragging the time marker is one way to view an animation sequence, but it
isn’t very user friendly.  To see how an animation will really look and
behave when played back in the final application (like Nanosaur), select
Play Sequence from the Animation menu.  The animation will play real-
time in the Skinned and Articulation windows.  Looping animations will
continue forever until you click the mouse.

Press the CTRL key to inhibit rendering in the Articulation window and
only display rendering in the Skinned window.  This will often improve the
frame rate of the rendering since it doesn’t have to render two separate
windows.



SETTING & EDITING KEYFRAMES

Let us suppose that you don’t like how the tail is moving in the “run”
animation sequence and you would like to change some of the keyframes.
This is really easy to do.

First, move the time index to the point in the animation where you would
like to edit the tail’s keyframe.  Now go to the Articulation window and
change the orientation of the tail as explained above.

Once the tail (and everything else) is in a position that you are happy with,
you can save the position as a keyframe in the animation.  Select Make
Keyframe from the Animation menu and new keyframes for all of the
joints which you have modified will be placed at the current time index in
the animation sequence.

You can move a keyframe in the timeline simply by clicking and dragging
on it.  Note, however, that you cannot drag a keyframe before any
keyframes prior to it, nor can you drag a keyframe beyond any keyframes
which are after it.

To delete a keyframe, simply click on it to select it and then press the
Delete key.

Keyframe Types

You have probably noticed that there are various different icons for the
keyframes.  These icons represent how the animation accelerates into and
out of a keyframe.  The various keyframe icons and their meanings are as
follows:

Linear acceleration

Ease In and Ease Out

Ease In

Ease Out



Linear acceleration means that interpolation of the animation from this
keyframe to the next will be linear, meaning it will be somewhat
mechanical looking.  The speed of motion will be constant from start to
finish.

Ease In and Ease Out indicates that the animation from the current
keyframe to the next will be more natural looking.  The animation will
accelerate into the motion and decelerate out of the motion.

The other two “ease” modes are combinations of acceleration and linear
animation.  Ease In means the animation will accelerate into the animation,
but no decelerate out of it.  Ease Out means the opposite.

Animation Event Keyframes

As mentioned earlier, the icons across the top of the Animation Timeline
window are special icons called “Animation Events”.  Each icon has a special
purpose:

Indicates that the animation should stop running.

Indicates that the animation should loop.

Indicates that the animation should reverse direction and zig-zag or
play backwards.  When the animation gets back to the beginning it will
reverse direction again and continue the zig-zag.

This is a “marker” animation event.  This indicates the time index to
which the loop and zig-zag events should loop back to.  Use this if you do
not want your animation to loop back to the beginning, but rather to
another point in the animation.

Play sound event.  This animation event tells the target application
(i.e. Nanosaur) to play a particular sound effect at this point in the
animation.  For example, when a character is walking you can use this



animation event to indicate that a footstep sound should be played at
certain times.

Set Flag event.  This tells the target application to set a particular flag
or to indicate that something special has happened.  For example, in a jump
animation, this flag is used to tell the game when the player should
actually leave the ground.  Or, in a basketball game this flag could indicate
the exact moment the basketball should leave the player’s hand during the
throw animation.

Clear Flag event.  Used to tell the target application that a flag should
be cleared.

To create a new Animation Event, simply move the time index to the point
where you want to create the new event and select Add Animation Event
from the Animation menu.  This will invoke the following dialog box:

This dialog box lets you specify which Animation Event you would like to
create.  The “Value” field lets you specify values for Play Sound, Set Flag,



and Clear Flag events.  In the case of a Play Sound event, this will indicate
the sound number you wish to have played.  For the flags, this value
indicates which flag to set or clear.
To edit an existing Animation Event, simply double-click on it to invoke
the Animation Event Info dialog box.

Note that the last Animation Event in any animation must be either a Stop,
Loop, or Zig-Zag event.  You cannot change the last event to anything else
(for obvious reasons).

CREATING NEW ANIMATION SEQUENCES

You now know most of what there is to know about creating and editing
animation sequences except for one thing:  how to create a new animation
sequence.  No problem, just select New Anim Sequence from the Animation
menu and you will get the following dialog box:

Simply enter the name of the new animation you are adding and then
press OK.  The Animation Timeline window will change to show your new
animation which will be entirely blank except for a Stop Event Icon.

Note that you can rename an animation by double-clicking on the
animation name in the Animation Timeline window.  This is a little buggy,
however, and you may have to fidget with it to get it to work.



ANIMATION EDITING MISCELLANY

Copy & Paste

Copy and past (from the Edit menu) work well for saving and restoring
positions of the skeleton.  Also, the Undo menu item will allow you to
undo-redo the last change to the skeleton’s orientation.

If you want to copy an orientation from one animation to another, simply
Copy at the time index, select the other animation, then Paste at the
desired time index.  Then set the keyframe and you’re done.

Adjust Across All Keyframes

This menu item in the Joint menu is very useful so read this carefully.
When this menu item is selected, any changes made to a joint will change
the same joint across all keyframes in all of the animations.  In other
words, if you rotate the head by 30 degrees on the x-axis while this
feature is active, the head will be rotated by 30 degrees on the x-axis in
every single keyframe that exists.

This comes in very useful when you change a 3D model such that the
animation doesn’t quite work anymore.  For example, suppose you shorted
the neck of a character, but the joints in the animation were all designed to
work with the long neck.  Now all of the animations look weird.  To fix it,
you can just move the neck joint to its new position.  Rather than doing
this for all ten zillion keyframes in your skeleton file, this will
automatically move the neck for you.

Note that all changes are “relative offsets”.  This means that rotating the
head to look up will not necessarily cause the head to look up in all of the
keyframes.  If the head was rotated 56 degrees to make it look up, then a
rotation of 56 degrees will be applied to all the keyframes.  It’s the
rotation delta that is applied, not the absolute rotation.



Zero Rotation

This menu item will reset a joint’s x, y, and z rotations to 0.0.  Sometimes
you can rotate a joint out of control and you can’t get it back to normal.
This will help you out by resetting it to 0.0.

BUILDING THE SKELETON

Okay, so far I’ve shown you how to use BioOreoPro using an existing
skeleton file.  Now comes the difficult part: creating your own skeleton file.

THE 3D SOURCE MODEL

Building the Model

The first step to creating your skeleton file is to build the 3D model of your
character.  On the Macintosh, the only 3D modeling application capable of
building good enough models to use in BioOreo Pro is Form*Z.  You are
more than welcome to attempt to use other modelers, but it has been my
experience that it is impossible to do a good job with anything but Form*Z.

The 3D models that you need to create for BioOreo Pro are what we call
“skinned” models.  This means that the entire model consists only of the
skin of the character.  There should be no vertices inside the body of limbs
of the character.  All of the vertices should be on the skin.

You should avoid creating vertices where are extremely close to each
other.  Later, you are going to have to select each vertex in this model, and
if two vertices are too close then it may be impossible to select one from
the other.  On the same note, the quantity of vertices is important as well.
You really want to have as few vertices as possible to get the most out of
the rendering performance.



Optimizing the Model

Once you have built your model and have exported it as a 3DMF file, you
must optimize it with 3DMF Optimizer 2.5 or newer.  This is not optional!
You must do this, or BioOreo Pro will freak out.

When you optimize the model with 3DMF Optimizer, use the following
settings:

Take special note that you DO NOT WANT TO INCLUDE FACE
NORMALS .  This has to do with the way the 3D engine deforms the
skinned models.  If you include face normals, bad things will happen when
the model is rendered.  Trust me.

Once your 3DMF file has been optimized you are free to use 3DMF Mapper
to texture map it, or you can go right back to BioOreo Pro and we can start
building the skeleton.



THE BONES EDITOR

When you launch BioOreo Pro, select Bones Editor from the Edit menu.
This will take you to the Bones Editor Dialog:

This is where you will build the skeleton for your character and where you
will assign vertices to joints.

Loading the Source 3DMF File

The first thing we need to do is load our optimized 3DMF file which we
want to use for our character.  Click the Load 3DMF button in the upper
right corner and then select the 3DMF file to use.  Let’s try loading the
sample model “Diloph_Fin.3df” in the SameFiles folder:



You can navigate the camera in this dialog similarly to the Articulation
window.  Click anywhere in the black space to rotate the object, and use
the up/down arrow keys to zoom in and out.

Moving A Joint

You will see a wireframe representation of your 3DMF file displayed.  Also
note the red, green, blue axes bars in the middle of the screen.  This new
skeleton always starts with one default joint.  The default joint is the hot-
spot or origin of the skeleton and should usually be placed in the center of
the model.  You can move a joint in the Bones editor just like moving a
joint in the Articulation window.  Just click on one of the axis bars and
drag.

Creating New Joints

To create a new joint, click the New Joint button.  This will create a new
joint which is a “child” of the previously selected joint.  A joint can have



any number of children joints.  For example, the body joint (the default
joint) will have children joints for the legs, tail, and neck.  Thin white lines
will show the connection among the various joints.

The general rule when creating and aligning joints is to create as few joints
as you can get away with in your model.  This version of BioOreo Pro has a
limit of 20 joints in a skeleton.  This isn’t a technical limit, it is a limit
written into the code to discourage you from using more than that since
anything over 20 joints is questionably large.  This sample skeleton has 16
joints.

Once you have created all of your joints and moved them to the
appropriate locations, you should have something that looks like this:

Assigning Points to Joints

Now comes the most tedious and boring part to this whole process:
assigning the model’s points to joints in the skeleton.  I apologize in
advance for the mental torment I am about to put you through.

The way BioOreo Pro performs animation is by deforming the skinned
3DMF file based on the orientation of the various joints in the skeleton.
The way it knows how to do this deformation is by looking at which



vertices (or points) in the 3DMF file are “attached” to which joints.  The
only way it knows this, is because you, the artist, have manually assigned
each and every vertex in the model to one of the joints.

Once you get good at this, it only takes maybe 20 minutes to do an entire
model, but that’s 20 minutes in Hell.  Nonetheless, there are ways to make
the process less painful.  Here’s what I do:

Start at the extremities and work inward.  Let’s start by selecting the jaw
joint.  When a joint is selected you only need to click on a vertex to toggle
it on and off.  You can press Command-Click to drag a bounding box around
a set of points to assign multiple points to the current joint.  Points which
are assigned to the current joint will be marked with a red dot:

Continue doing this for all of the joints, but save the “body” joint for last.
Since the body joint has the most vertices assigned to it, we can do a little
shortcut at the end.

Since all of the other points have been assigned to other joints, we can click
on the body joint to select it and then press the Select Unattached Points
button to cause all of the remaining points to be assigned to the currently
selected joint – the body joint.



Clicking this button will also make it easier to see if you missed any points
in other places in the model.  For example, if you suddenly see a red dot on
the foot, then you know that you missed that point when assigning points
to the foot.  Simply click the red dot to unassign it from the body, select
the foot joint, and re-click the point to reassign it.

Another way to detect that you have missed a point and it is not attached
to any joint is to return to the Articulation window and try moving the
whole model.  Any points which are not attached to a joint will not move
and the model will “tear” or “rip” when moved.  Be very careful that all of
the points are assigned to joints before attempting to use the skeleton in
an application like Nanosaur.  Nanosaur will likely crash if you give it a
bad skeleton file like that.

Once you are done assigning points to joints, click OK to exit the dialog.  If
you decided to change your 3D model at some point, there is a fair chance
that your point assignments will remain valid if the number of vertices in
the 3DMF model do not change.  If, however, you modify the number of
vertices in your 3DMF model, then you will almost assuredly have to
reassign all of the points to joints again.  So, it is a good idea to make sure
you like your 3D model the way it is before building a skeleton for it in
BioOreo Pro.  While creating Nanosaur, I probably had to reassign points to
the joints in all of the dinosaurs half a dozen times.  It’s just something you
get used to I guess.

FINAL NOTES

That pretty much covers it for BioOreo Pro.  Just remember that this is an
in-house tool, and as such you should save your work often and make
backups.  There are other menu items which I did not discuss in the
documentation, but a little experimentation on your behalf will reveal the
functions of those menu items.

The only other menu Item worth a small note is the Change Editing Scale
menu item in the Edit menu.  BioOreoPro assumes the source models are a
particular size – that size is what Nanosaur likes to have.  BioOreo Pro by
default expects source models to be around 300 units in size.  However,
your specific application for which you are creating skeleton files may be



using a different scale factor. The Change Editing Scale menu item will
allow you to change the scale of the system in BioOreo Pro.  A scale value
of 2 will double the size of the world such that a model of about 600 units
in size will fit.  Or a scale value of 0.1 will shrink the world by 1/10th such
that a model of 30 units will fit nicely.  In general, however, I recommend
you stick with the default scale for this tool.

Since this tool displays several 3D windows using QuickDraw 3D, it is
highly recommended that you have between 4 and 8 Megs of VRAM on
your ATI 3D card to use this tool.  Cards with 2 Megs of VRAM will
probably suffer texture and/or performance issues as that it simply not
enough VRAM to have to many 3D windows active at one time.


